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General Fireworks Information
Fireworks is a software authoring tool for creating interactive Web pages including menus,
rollovers and pop-up graphics without having
to learn HTML, javascript and an interactive
Web package like Flash. Fireworks can also alter graphics and then optimize those graphics
for the Web. Fireworks has also more recently
been viewed as a design tool for the web for
creating web page objects that can be used
throughout a web site or in a web production
environment.


Starting Fireworks
To begin Fireworks on a Macintosh, look on
the Macintosh lower toolbar inside the Applications folder and double-click on the Fireworks application.
On a Windows system, click under the Start
icon then Select All Programs, Adobe Design, then Adobe Fireworks.
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Once you have Fireworks started, pull down
under File to New. Create a 480 pixel Width
and 360 pixel Heigth file with a 72 pixels
per inch resolution then click the OK button.
Next pull down under File to Save As, name
your file screen.png & save it to your desktop.
Fireworks Layout
There are five distinct areas within Fireworks: the Tools
Panel, Menubar, the Canvas/Work Area, the Floating
Panels Area, and the Properties Panel.
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You work in the Canvas area using tools from
the Tools Panel. The Floating panels give you
information and additional options for Canvas
items while the Properties Panel gives you specific information on the currently selected Canvas item. You can, of course, use the menubar
to navigate the various selections and options
within Fireworks.


Tools Panel
The Tools Panel has six distinct areas of tools:
Select, Bitmap, Vector, Web, Colors and View.
The Select tools are used to select items on
the canvas. The Bitmap tools are used to alter imported bitmap graphics. Fireworks normally creates vector graphics which can be
altered using the Vector tools. The Web
tools are tools used in designing parts of a
Web page while the Colors tools allow you
to choose foreground and background colors
and the View tools show various views of the
canvas. The major tools you normally use are
the Pointer, Lasso, Hide/Show Slices, Slice,
Stroke and Fill tools.
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Project- Interactive Drive-in
Normally with Fireworks one creates interactive web objects like standard and disjoint rectangular rollover areas as well as drop-down or
pop-up menus. One can also create round interactive areas known as hotspots. Fireworks
also contains a common library of bullets, buttons and simple animations; plus also gives you
the ability to both clean-up and create web
graphics and buttons from scratch.
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This projects begins with graphic clean-up and
adds both standard and disjoint rollovers as
well as adding buttons and a drop-down menu.


Getting Started
Open a Web browser and go to:
http://css.ait.iastate.edu/Fireworks/Data1/
then download and unzip the file fireworks.zip
to your desktop.
Within Fireworks on the Menubar, pull down
under File to Import and choose the file internet.gif. You will see an insertion corner on
the screen. Line the insertion corner up with
the center of the screen then click. Next use
the pointer tool to move the drive-in so that it
lines up with the lower right hand corner of the
canvas. Click anywhere outside the selected
image to deselect it.
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Adding Some Text
Select the Text Tool then in the Properties
area set the font size to around 20 and choose
an appropriately bold font type. For this example, I used Baskerville and set the font size
to 17.
Click in the upper right hand corner of the
canvas and type in Welcome to the Internet Drive-in. Now Showing. . . Click in
the lower left hand corner and type in Hungry? How about a Snack? You can use the
Pointer Tool to move the text around once
you type it in and you can reselect a text area
with the Type Tool and edit a text block.
Notice in the right panels that you are producing a Layer for each item that you add to the
canvas.
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Cleaning Up the Drive-In
Click on the Layers tab on the right. Notice
that each time you add a new item that it normally goes onto a new layer all on its own.
Select the Bitmap Layer and use the Eraser
Tool to erase the dark line on the left edge
of the image. Remember that you can set the
Properties for the Eraser once it is selected.
Next select the Pointer Tool and click anywhere in the white area away from the two text
blocks. This will select the background layer
or the main canvas. Go to the the Properties
area and select the canvas color block. Notice
that your pointer becomes an eyedropper tool.
Select as your color some of the background
color from the sky area behind the drive-in.
Finally select the Bitmap Layer then pull down
under the Lasso Tool to select the Polygon
Lasso Tool. Point and click your way around
to select just the drive-in screen itself ending
up back where you started. You can magnify
the size of the canvas in the lower right.
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Next pull down under Edit to Copy then pull
down under Edit to Paste and finally press the
Escape key. You just pasted a second bitmap
image of just the drive-in over the first bitmap
image.
Now we are going to add an effect to the image that we just cut-out. Select the smaller
bitmap image layer then go down to the Properties area and click on the + sign next to
Filters:. There are various effects here that
you can add to any Layer of your canvas. Pull
down to Shadow and Glow and then over to
Glow. Take the default values and just click
away from the option area and your drive-in
screen will have added a radiant glow.
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Click on the smaller Bitmap layer again to
make it active. In the Properties area, under
Effects you should now see Glow listed. You
can double-click on Glow to alter it or click on
Glow then click the − sign to remove it. Try
altering this effect a little bit then click in the
canvas background area to continue.


Adding Some Buttons
Let’s add some interactivity. Pull down under
Window to Common Library and open up
the Buttons area. Select the button named
button 03 then click and drag that button
onto the center of the canvas. When you do
that, your canvas will also be automatically divided with red lines into slice zones for interactivity.
With your button selected, pull down under
Modify to Transform then over to Scale and
enlarge your button by about 50%. Next use
the Pointer Tool and move the button to the
upper left hand corner.
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With the button selected, pull down under Edit
to Clone which makes a copy of your button
that appears right on top of the old button.
Use the Arrow Keys in combination with the
Shift key to move the new button below the
old button. Do this two more times to make
four buttons going vertically down from the
upper left hand corner.

Select the first button with the Pointer Tool.
Go to the Properites area and notice that you
can set the Text: and Link: for this button.
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Set the Text to Home and the Link to index.html for normal web site use. Set the
Text: for your other buttons to Prices, Showtimes and History then set the Links: for your
other buttons to any valid URL, for instance:
http://css.ait.iastate.edu/, http://www.yahoo.com/ or
http://www.google.com/. Once you’ve selected a button, you can use the Styles tab (Window → Styles) to
change it’s style.
Click the Preview tab just under the Menubar on the
top part of your screen to see how your buttons look
then pull down under File to Preview in Browser to
actually try out your buttons. Once you are finished,
drop out of the browser then select the Original tab to
continue.
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Creating a Rollover
The areas in green on your screen are known
as slices. These areas allow you to add interactivity. Fireworks automatically divides your
canvas into slice zones which are represented
by red lines. You can add slices to your slice
zones on your own by using the Slice Tool.
Select the Slice Tool then click and drag a
rectangular area in the lower left hand corner of
your screen. Once you complete the area, you
will notice that it is now in green and available
for interactivity. Do the same thing for the
drive-in screen itself and for the upper right
hand corner.
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For use in the rollover, we will need to add a
new State for the canvas. Pull down under
Edit to Insert then over to State. Notice
that your buttons stay there but everything
else disappears. Also note the State number in
the lower right hand corner. Select the Hide
Slices tool to get a good look at the canvas.
Now that we have a second state, let’s add
our rollover items. Pull down under File to Import and bring in nook2.gif then import fountain2.gif. Put nook2.gif in the lower left hand
corner and fountain2.gif in the upper right.
Click the Show Slices tool to make sure you
stay in the proper zones. You can also add
some text as illustrated below:
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Click the Previous State button /| on the
right hand corner of the canvas near the State
number to return to the first state. Click on
Show Slices if it is not already on.
Using the Pointer Tool, click the slice over
the internet drive-in. A behavior handle should
appear on the center of the slice. Click and
drag the behavior handle to the upper right
hand slice and release. The Swap Image screen
will appear. Choose to swap the image from
State 2 then click on OK.
Click on the lower left hand slice until the
behavior handle appears. Click and drag the
behavior handle back to its own slice and release. The Swap Image screen will appear
again. Choose to swap the image from State
2 then click on OK.
14

Click the Hide Slices tool then click the Preview tab to try out your interactivity. When
you go over the internet drive-in, the fountain
should appear in the upper right hand corner (a
disjoint rollover). When you go over the Hungry? area, the snack bar information should
appear (a standard rollover).

If it didn’t turn out quite right, you can always
go back, turn on slices and reselect that slice
then click on the behavior handle and select to
Delete All Behaviors. Click the Original tab
to continue.
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Drop-Down/Pop-up Menu
Click the Show Slices tool then use the Pointer
Tool and pull down the top spar on the upper
right slice to make a small rectangular area
which currently doesn’t have any slice zones.
Use the Rectangle tool to make a long, black
rectangular box in the upper right. Grab the
Text tool and in white add the words: Hours,
Gift Certificates and For Kids; on top of the
black rectangular box.

Use the Slice Tool and create slice zones on
top of each of the words for the drop-down
menu. Grag the Pointer Tool and click on
the slice over Hours.
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To add a drop-down/pop-up menu to this slice,
click on the Behavior Handle and pull down
to Add Pop-up Menu. The pop-up menu
editor will appear. Fill out the menu as listed
below. You can use the + button to add extra
menu lines. Since this is an informational dropdown, put in a # instead of a URL for the Link
information.

Click on the Appearance tab and make sure that you
are creating a Vertical Menu then click on the Position
tab and choose the option to put the submenu directly
under the current position. Notice that Fireworks does
give you a lot of menu options.
Press the Done button when you are finished then test
out your menu by pulling down under File to Preview
in Browser.
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Do the same thing for the Gift Certificates
slice and create an informational drop-down
menu with values of $10, $25, $50 and See
Manager for details.
Do a similiar thing for the For Kids slice but
this slice will add links and a submenu as well.
When the pop-up menu editor appears, fill out
the menu as listed below. You can use the +
button to add extra menu lines as before but
you can also us the Indent Menu button to
indent a menu item under another menu item.

Press the Done button when you are finished then Preview your file in the Browser.
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Menu Title Rollovers - Extra Credit
To make your drop-down menu even more professional
looking, you may want to add a rollover for your menu
titles. To start with, turn off showing slices. Next copy
and paste the rectangular black box and the top menu
items from state one to state two. While in state two,
highlight each of the text items and make them slightly
bigger and in a different color.
Now we are setup for the rollover. Go back to state one
and turn on slices then make sure the Behaviors panel is
up by pulling down under Window to Behaviors. Next
using the pointer tool, click the slice over the Hours
text. Look in the Behaviors panel and you should see
one Mouseover event.
You can add multiple events to a slice by going under
the Plus sign and pulling down to a behavior that you
would like to add. Pull down under the Plus sign to
Swap Image. Everything should default correctly here
as Fireworks should choose to rollover from frame 2,
preload the frame 2 image and restore the image on
Mouseout. Simply click the OK button. Do this for the
other two top menu textual items as well.
Finally test out your menu by pulling down under File
to Preview in Browser. The rollover should highlight
the word at the same time that the drop-down menu
appears below the highlighted word. This technique is
used quite often on Web sites and it use illustrates how
to add multiple events to a slice.
19



Exporting
Click on Hide Slices to hide your slice zones
then pull down under File to Image Preview.
Fireworks will estimate how long it will take
your image to appear in a browser. You can
try out your image in different formats so you
can choose exactly what you need.
Click Export once you have selected a format.
Save your exported file to a new folder and
name the file index.html. You will want to
use the following additional options— Save as:
HTML and Images, HTML Export HTML
file and Slices: Export Slices. You also normally want to check the options Include Areas
Without Slices, Current Page Only and Put
Images in a Subfolder. Click Save to continue.
Go to the folder that gets created and click on the index.html file to try out your creation. Fireworks HTML
and even .png files can be easily imported into Dreamweaver.
With slightly different export options, Fireworks files can
also export to other HTML editors or even to Flash or
Illustrator.
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References
While you are in Fireworks, pull down under
Help → Fireworks Help to find two excellent
tutorials: Using Fireworks and Extending Fireworks.
Adobe Fireworks Support Center:
http://www.adobe.com/support/fireworks/ also has
an excellent Getting Started area.
My own Fireworks class series and examples:
http://css.ait.iastate.edu/Fireworks/
Other References:
Adobe Fireworks CS4 How–to’s: 100 Essential Techniques by Jim Babbage (2008) Adobe Press.
Adobe Fireworks CS4 Essential Training by Jim Babbage (2008) Online Video Tutorial from lynda.com.
Adobe Fireworks CS4 Classroom in a Book by Adobe
Creative (2009) Adobe Press.
Adobe Fireworks CS4 Step by Step Training by Noble
Desktop (2009) Noble Desktop.
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Appendix: Altering Buttons
To alter a button within Fireworks, just go to the main
screen and double-click on it just as you would in Adobe
Flash. Let’s alter our buttons so that they have a larger
text font. Go to the main screen, hide your slices and
make sure that the Original tab is pressed. Doubleclick on the Home button and you will be taken to a
symbol alteration area.

Click on the Label Layer within the Layers tabbed panel
area. Then select the Text Tool and highlight the word
Button. Increase the font size and change the font type
for the button. Also select the Pointer Tool and move
the Scaling Guides so that they surround the text area.
The Guide Lines are used when changing the size of the
button so that the area outside of the guide lines do not
get distorted.
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When you are finished go to the top of the screen and
click on the Page 1 button and then Save and Preview
your new page. You should see that you have altered
all of your buttons with the new lettering. You can do
this with the shape of the button as well. You might
also notice that the lettering reverts to its old self when
you go over the button. The reversion happens because
buttons actually have four states: On, Over, Down and
Over While Down; and you have only revised one of the
states.
Go back and revise your button again but this time alter
the label layer in all four states. You can use the Copy
Down Graphic button and the Edit → Copy function
from the menubar as well to copy and/or copy and paste
the button down from state to state.

23

